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Documents

Document status

Documents are in certain states in which authorised user groups can perform actions on them, with
read or write access. This is shown in the document display by a corresponding symbol.

Symbol Status Meaning
] [ View only The document can only be opened for viewing.
Locked The document cannot be edited or viewed.
:J 5 Created The document is created and can be taken out for editing.
Filed The document is filed and can be taken for editing.
O In progress The document is in progress. The editing user is also displayed.

V Released The document is released.

The document is filed and must be reviewed by the responsible
user.

Waiting for review

The document has been checked and must be released by the
Checked .
responsible user.

03 |Iltem master in progress|The properties of the document are currently being edited.

Q>D<> Parts list in progress The parts list is in progress.

e

F Link There is a link for the document.
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Symbol

Status Meaning

O

In progress by current

user The document is in progress by the current user.

Additional information about the document

Meaning

The document contains appendices

The document is a variant part

The document is a variant assembly

The document is a flexible built-in part/assembly

The document is a variant part with appendix parts

The document is a variant assembly with appendix parts

The document is a flexible part/assembly with appendix parts

The last release of the document has been withdrawn and the document is waiting for a
new release.

The entry is a link to a document.

Y JB OB 0N

Additional notes exist for the document.

Redlinings exist for the document.

The document must be synchronised.
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Document list

The document list shows all documents in the currently selected folder.

Dokumente X b

O ' 8 ¥ DokumentNr. ~ Benennungl ~ Benennung2 ~ Typ - | Status ~  Datum ~*  Anwender =1 = | LIEFERANT
<all> p <all> ,C-‘ <all> p <all» ,C <all> p <all> ,C-‘ <all> p <all> p

¥ 201501-B08-001 BGR Baugruppe Freigegeben 12.02.2018 10:21:22 admin

: = 201501-E08-001 Profil unten Einzelteil Freigegeben 12.02.2018 10:32:54 admin

Selecting a document in the list displays the document properties.

P CAD » 201501 P Konstruktion » 03 : Grundaufbau

The title bar of the document list shows the currently selected folder path. Click on a folder path name
to switch to the corresponding folder above it.

If you press the middle mouse button, a tooltip window with further document properties is displayed.

' 8 % Dokumert-Nr. *  Benennung 1 * Bene.. * Typ *  Status
<all: 2=l ol Pl 2l
% ] 201402-B00-001 Grundaufbau Baugruppe Abgeleat
% ] EDW/j{}EDD-Dm Grundplatte Einzelteil Abgeleat
™y

i 201402-E00-001
X

Dokument-Nr: 201402-E00-001
Benennungl : Grundplatte

Benennung?2 :
Benennung3 :
Material:
Lieferant:
Kommentar:
L v
Menu options:
t\]@ Properties Opens the item master mask to edit or view the document properties.
£
New Creates a new document.
Copy Copies the selected document.
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Ol Delete Deletes the selected documents.
Ql View Displays the document in the viewer.
Takes the document in work (check out) and opens the document file
Open in the corresponding application for editing. The status of the
document is ,In work®".
——
, Takes the document in work and opens the drawing file in the
Open Drawing

corresponding application for editing.

Open with selection

You can select the document file to open.

] E} Undo Undoes the last work in progress.
Store Stores (checks in) the document. Other users can access the
document again. The status of the document is ,filed”.
L
Ol Release Sets the status of the document to ,Released”.

Take back release

The last release is taken back. The document is given the status ,In
progress”.

Cancel release

Cancels the release. The document is then given the status ,In
progress”.

Partial use

Displays the partial use of the document.

Go to storage folder

Navigates to the storage folder of the selected document.

by*“

Go to ,Replaced

Navigates to the document that is defined as a replacement
document.

Refresh

Refreshes the current document list.

Document List Tabs

By default, a document list exists to display the documents that are in the selected folder or result

from the search.

Tabs allow quick switching between several different document lists.

-, Suchergebnisse X

' Dokumente | 071: Gestell |# 03:Grundaufbau [ | Dokumentation
B ¢ B8 ¥ Dokument-Nr ~ Benennungl ~ Benennung2 ~ Typ * Status ~ Datum ~  Anwender
<all> O <l O <l L2 < L2 <l L2 <l O <l
& v 201403-E00-001 Platte Test Einzelteil Gepruft 09.03.2021 0%:13:10 mac
& 201403-E00-002 Abdeckung Einzelteil Freigegeben 09.03.2021 08:54.1% mac

The active tab receives new content when a new folder is selected in the structure.
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A tab therefore retains its content until a new folder is selected in the structure.

Context menu for controlling the tabs
Right-clicking on a tab opens a context menu:

Meuer Tab Strg+T

Diesen Tab schlieBen Strg+W
Alle Tabs schliefen Strg+Umschalt+W
Gehe zu ..,
New tab Ctrl+T Creates a new empty tab and activates it.
Close this . , . .
tab Ctrl+W Closes the active tab. The previous tab is activated.
ggze all Ctrl+Shift+W/|Closes all tabs except the first tab.
Synchronises the navigation structure with the active tab.
If the configuration parameter [structure.synctoactivetab] is activated, the
Go to... . , ) :
corresponding parent element in the structure is automatically selected
when switching between tabs.

To activate a tab, click on the tab with the mouse.

Clicking on a tab with the middle mouse button also closes it.

The first tab cannot be closed.

The name of a tab always corresponds to the current parent element except for the first tab.
When the mouse pointer hovers over a tab, a tooltip shows the current folder path.

Quickly create a new tab
By holding down the Shift key for all functions that result in a new content in the document list, a new

tab is automatically created with the result. These are e.g.:

¢ Click on a folder

Direct search

Part Usage > Search Results

Go to storage folder

Parts list > Show articles / Show all articles

Document versions
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Documents with versioning typically go through the following states:

Document files can only be changed when they have the status ,In progress”“. The document
properties can be changed at any time except for released documents. A new version is created
automatically.

If a user takes a document ,In work“, no other user has access to the document. After a stored
document is released, its revision number also increases. The change status of a document is made
up of the revision and version number.

Ex.: Revision 3.6 = 6th version derived from the 3rd revision

Create new document

Ribbon: Document ,, New {[Ctri]+[N1}
Context menu: Document list “ New
Toolbox: New

Before a new document can be created, the project folder must be selected.
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—
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Document number

Displays the new document number. The document number is automatically assigned by the system.
Depending on the configuration, a ,,speaking” or classifying number can be created here. The
document number is unique throughout the system.

Create in

Defines the folder where the new document will be stored. A folder must be selected.

Document type

Defines the document type of the new document. A document type must be selected. Depending on
the configuration, the document type is already predefined with the selection of a folder.
Namingl/Naming2

Define a title for the new document. The title is used in conjunction with the document number to
generate the file name.

Template file

Select a template file for the new document. A list of template files is linked to the document type.

When all entries have been made, confirm the dialogue with OK. The properties dialogue then
appears in order to define further document features.

Document properties

Properties tab

Eigenschaften

—
=

Displays general and specific properties of a document. For example, the manufacturer, the various
comments on it or the weight of an item.

speedyPDM - Wiki - https://wiki.speedy-pdm.de/


https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokumentenverwaltung:dwwin_dlgdocumentnew.png
https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokumentenverwaltung:dwwin_dlgdocumentnew.png
https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:karteireiter_eigenschaften.png
https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:karteireiter_eigenschaften.png

Last update: . . . il : id—an- . .
2023/01/25 07:32 en:speedy:10_explorer:20_documents https://wiki.speedy-pdm.de/doku.php?id=en:speedy:10_explorer:20_documents

Tab Versions

Varzioner

53

Displays the versions and revisions of a document. Each document is displayed with the status, the
editor and the document ID.

Menu options:

(i View Displays the selected version in the viewer.
]ﬁ Open Opens the selected version in the associated application with write
Mg | P protection.

Makes the selected version the current version. A new version is created
at the end of the version list with the data of the selected version.

Shows the differences between the selected version and the current

Set Current

Show differences

version.
Deletes all versions between the selected revision and the previous
Purge release .
revision.
]\_\]& Properties Displays the document properties of the selected version.
£
Files tab
Dateien
. ﬂl‘.‘:.‘:"-h'."':' NS . 142 M8 ' Tl 210G .'.'.'."1.'/ .'Z.'.'.".'Z.'?':’
&

Displays all files that have been stored with this document. Documents can be added by drag & drop
or by menu options. Furthermore, you can select from templates that are defined by the document

type.

Menu options:
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View

Displays the selected document in the viewer.

Open

Opens the selected file in the associated application for editing.

Store

Stores (checks in) the document. Other users can access the document
again. The status of the document is ,filed”.

Add template

Adds a new document file based on a defined template.

Add File

Adds any file to the document.

Delete file

Deletes the selected file.

Export

Exports the selected file to a local directory.

Send message...

S ends the marked file as an attachment to an email. The email window of
your email application opens.

S5, b 76760 b

Sends the marked file packed as a ZIP attachment to an email. The email

(s) Send Zip... window of your email application opens.
| Properties
4 > The file list can be influenced by the following parameter: N
[document.files.sortorder], [session.export.hasfileexportevent],
\_ [session.export.renameondragdrop], [document.copyout.undecorate]. Y

Relations tab

Relationen
[ =

e

Tasermry Baraarargl Miwine PFlshorshp

...........
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Displays (relation/references) documents used by the document. Other articles/documents used for
this document. Double-click on them for more information. You can add relations by: Right Mouse
Button > Add Relation

Menu options:

[

Q View Displays the selected document in the viewer.

Add relations  |Adds a new relation to another document.
Delete relation |Deletes the selected relation.

Update relations|Updates the relations.

Link properties |Displays the link properties.

) Properties Displays the document properties of the referenced document.

=

Parts Usage tab

Teilewvenwandu ng

0 Deerasbe Bergwwrs | Berawarnl

;l '

Displays the parts usage. The list shows all assemblies in which the document is installed. Double-
click to display more detailed information.

Menu options:

View Displays the selected document in the viewer.

oy

Update part usage /Updates the part usage list.

P
&

Variants tab
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All variants (descending articles) of an article are displayed here. Double-click to display more
detailed information.

Menu options:

gil View Displays the selected document in the viewer.

Delete relation|Deletes the selected variant.
]\_\]& Properties Displays the document properties of the variant document.
&

Attachment Documents tab

Displays all appendix documents.

Anhangdokimerte

(i st 4 e ey | e o'y T it b il

Attachments are links to other items that are related to this item or that are frequently used with this
item. Example: A proximity switch is often installed with a cylinder. The cylinder receives the
proximity switch as an appendix part. If you now search for the cylinder in Solidworks in order to
install it in an assembly, the matching proximity switch is also immediately available and does not
have to be searched for first.

Menu options:

C]\_\i View Displays the selected document in the viewer.

]ﬁ Takes the document in work (check out) and opens the document file
. Open in the corresponding application for editing. The status of the

IL ) document is ,,In work®.

Puts the document to work (check out) and opens the document file in
Open Drawing the corresponding application for editing. The status of the document
is ,In progress*”.

Open with selection|You can select the document file to open.
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Iﬁ Store Stores (checks in) the document. Other users can access the
document again. The status of the document is ,Filed“.

= 4

Release Sets the status of the document to ,Released”.

JJ O-L¢

Add Appendix Part |Adds a new reference.

Delete attachment |Deletes the reference.

Properties Displays the document properties of the linked document.

Sl %

Notes tab

Motizen

CEN] [F= e kgl

th-

Notes on documents can be stored here by dragging and dropping. In the menu bar, it is possible to
create notes directly.

Edit document properties

- Ribbon: Document> Properties {[Ctri]+[E]}

- Context menu: Properties {[Ctrl]+[E]}

- Toolbox properties

- Double click on the document in the document list

Opens the properties dialogue to edit the document properties
General tab

Displays general system information about the document. Data can be changed or a comment can be
added. The manufacturer, supplier, price, material, etc. are queried.
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Meaning of the input fields:

Document hame

The complete document name is displayed here.

If an item (part/assembly) is used once, the document name is highlighted in pink.
If an item (part/assembly) is used more than once, the document name is
highlighted in red.

If the item has already been exported once, the document name appears in blue.

Document type

Shows the document type.

Designation 1/2/3

Article designation

Manufacturer Manufacturer
Supplier Supplier

Indicates whether the item is a spare part and should be output in the spare parts
Spare part

parts list.

Unit of measure

Select a unit of measure from the list.

Price

Enter the price per unit of measure.

Enter a material name or select a material from the list.

Material By selecting the Material button, you can search for a material in the material
database.
Enter a surface finish or select one from the list.

Surface By selecting a material beforehand, the selection options of the list are limited
according to the material properties.

Weight Specifies the part weight based on the data calculated by Solidworks.

g For single parts, the weight depends on the density defined with the material.
. . Dimensions of the component. (e.g. length, width, height, thickness, ...) depending

Dimensions ) .
on the dimension type

Size Specifies the size of the part based on the geometry designed in Solidworks.

Properties tab

Displays the customised item properties of a document. Values can be changed. Mainly the previous
settings are shown, but they will be described in more detail.
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Variants tab

Displays all variants (child items) of a variant item. Variables can be changed. Press [STR]+[mouse
click] to open the formula editor for variant articles. This allows you to formulate a formula after
naming the variants of an article, for example.

E Aymar

&

See Variantenartikel

Versions tab

Here you can view the different versions, see their status and find out who edited the article. It is
shown by which user and at what time the article was created. In the lower window, all previous
versions of this article are displayed. If the article was copied, the URSPRUNG field indicates the origin
of the copy.
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Remove/open document

Ribbon: Document ,, Open {[Ctri]+[O]}

Extract toolbox

Open toolbox

Context menu document list “ Open

Select the documents to be opened in the document list. The documents receive the status In work
and can now be edited by you or the application assigned to the file type is started and the document
file is opened for editing. While a document is removed and has the status In work, it cannot be edited
by other users, the document is locked for other users. If the document is released, an additional
security prompt appears. You have the choice of opening the document read-only or unblocking it and
editing it.

Dokument: [201501-B00-005 {2.00] - [Freigegeben| L

Ansehen [ Viesen

(D Starrored ation ured dia Datel wind S iigess b gadlhel

Hazrburien

(D Samavedaten und dk Dated wind 20 Baratabung QoW

Open with selection

Menu: File > Open with selection
Context menu: Open with selection
Opens a window in which you can select the file you want to edit.
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File document

Ribbon: Document ,, File {[CtrI1+[S1}
File toolbox
Context menu document list “ File

Select the documents to be filed in the document list. The documents receive the status Filed and can
now be edited by other users. If the document was previously released, an additional prompt appears.

Ipkument ablegen: - X1402-E0060
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New release
Documents are filed and directly released again.

File document

Documents are only filed. A new release can be created later.

Leave current release
All changes are discarded.

Share document

Ribbon: Document ,, Share {[Ctri]+[R]}
Share Toolbox
Context menu document list “ Share
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Release dialogue

Select all documents to be released in the document list. The documents are given the status
released.

All files of a released document are stored in a special directory so that the released status is retained
in case of further editing (new version). The file status of an older release can be retrieved at any
time. Of course, this also applies to assemblies and their references to other assemblies and parts.

The release dialogue shows all documents to be released and referenced.

In the table, a different ,,New Version“ can also be assigned manually for each document.

A release comment can be assigned for each document. If the check box , Transfer value change to all
documents” is activated, a comment entered once is transferred to all documents. The switch must
be set before a comment is entered so that the values are transferred.

The release comment can, for example, be printed in the header of a drawing in the change index.

The following options are available for the release:

Save parts list as PDF
The parts lists are also saved as a PDF file on the item when they are released.
(See also configuration parameter [document.release.bomfiletype])

Export to ERP
The article and parts list data are transferred to the ERP system upon release.
(See also configuration parameter [session.export.onrelease])

Send message
After approval, a message is sent to all set recipients.
(See also configuration parameter [document.release.message.xxx])

Reference work file to release
The references of the work files of assemblies are also referenced to the shared files.
(See also configuration parameter [document.release.relink.work])

Create neutral formats

Neutral formats are created or renewed.

The switch is a 3-value switch:

If the switch is deactivated, no neutral formats are created.
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If the switch is activated, neutral formats are created from all files, regardless of whether they have
already been released.

If the switch is partially activated, neutral formats are only created from files that are to be newly
released.

Check

All documents that have not yet been released are checked to see whether any mandatory fields
defined in the item master have been filled in correctly.

The check can be carried out manually by clicking on the ,Check” button, otherwise the check is
carried out automatically before release.

If mandatory fields are not filled in, a corresponding error message is displayed.

Via the configuration switch document.release.extended.checkrevisions you can set whether the
check should also check for older revisions. If a newer revision exists for a document, it is displayed in
blue in the list. blue in the list.

Double-click on an entry in the list to open the item master.
Please note that for assemblies that contain sub-parts, the item master is only called up by holding
down the control key [CTRL+double-click].

ﬂ Some options may not be available in the dialogue or may be greyed out, depending
on the administrative setting (configuration parameter is defined as Global).

The simple release dialogue can be used by deactivating the configuration parameter
[document.release.extended].

.

Simple release dialogue

View document

Ribbon: File ,, View {[CtrI]+[Q]}

View toolbox

Context menu document list “ View

Select the documents you want to view in the viewer. The viewer linked to the corresponding file type
is started and displays the document file. If no specific viewer application is defined, the document file
will be opened in the appropriate application in read-only mode. If there is more than one file for the
selected document, you must select the file to be viewed.
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Document preview

If you select a document in the document list, a quick view is displayed in the document preview. If
there are several files for the selected document, a tab with the corresponding quick view is displayed
for each file. Clicking on a tab displays the corresponding quick view.

Vorschau * 8 X

By pressing the middle mouse button in the document preview area, you can enlarge the quick view
for some file types. The enlargement is either full-screen or in the available view size.

The preview window remembers the last file type displayed. When switching to another document, it
tries to display the previously remembered file type again. However, if the sort order of the file list is
controlled by the parameter [document.files.sortorder], the first file is always displayed in the preview
window. If no sort order is defined but the parameter [document.preview.openfiletype] is activated,
the first available file type from the list of standard file types ([document.openfiletype] +
[document.openfiletype?2]) is selected.

[document.preview.openfiletype], [document.files.showhidden],

The preview can be influenced by the following parameters:
[document.files.exthide], [document.files.sortorder].

Part usage

Ribbon: Properties ,, Part Usage
Context menu: Part usage
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Displays the detailed part usage of the document.

Compare documents

Ribbon: Properties “ Compare Documents

Displays the selected documents and compares them on the basis of the first selected document. The
differences are shown with a text marked in red. Nothing can be edited in this dialogue, it is for
comparison purposes only.

-

Edit documents (mass data entry)

Ribbon: Properties ,, Edit documents

Displays the selected documents. The properties of the selected documents can now be edited. As
soon as there are write-protected documents, they are greyed out. The child documents of a
document can be displayed via the button Show Child Documents can also be edited. In this case,
the basic article is write-protected.

.

The dialogue is structured like an Excel table in which the individual cells can be edited. As usual in
Excel, pressing Enter jumps from one cell to the next.

Via the button Transfer value change to all documents you can have the entire column filled in
automatically. l.e. if this switch is set, as soon as you change something in one document, this is
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applied to all other documents.

With the switch Transfer value changes to selected documents you can have a column filled in
automatically for selected documents. l.e. if this switch is set, as soon as you change something in a
document, this is applied to all currently selected documents. Multiple documents can be selected by
holding down the Ctrl key while clicking or by selecting a range with the Shift key. Then simply type in
the desired value. The dialogue then applies the values to the selected lines.

Column descriptions can be defined for mass data entry. These column descriptions must be of the
type ,edit massedit document mass data“. If several column descriptions are defined, they can
be selected from a list in the dialogue. The dialogue remembers the last selected column description
and opens the dialogue with it the next time. In the column description you can define which columns
remain pinned when scrolling. To do this, the check mark Indented must be activated. If this is
ticked, the column is permanently defined. The columns can be specified in the column description
with width. With the checkbox Automatic column width the width of the columns can also be
automatically adapted to the window size.

Reference Manager

Ribbon: Document “ Properties , Reference Manager

Copy document

Ribbon: File “ Copy

Copy toolbox

Context menu document list ,, Copy
Creates a copy of the selected document.

The document and all associated files are displayed in the structure. The document selected for
copying is already marked.

If the document to be copied is an assembly that references parts or subassemblies, these are also
displayed in the structure and can be marked for copying.

e By selecting ,New item number” you determine that the New dialogue for specifying the item
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number or designation is called up for each new document.

e The option ,Edit item properties” opens the properties dialogue for each copied document.

e The option ,,Copy links" defines whether the links to appendix parts or links to other documents
are also copied.

e The option ,Reference to latest version” always lets the copied documents reference the latest
version of a file. The copy dialogue shows the current references of the files. However, if a
newer version of a file exists in the meantime, this option ensures that the most recent version
is used.

The following configuration parameters influence the copy dialogue:

[document.copy.checkbaseparts], [document.copy.checkprojectnotequal],
@ [document.copy.copyattached], [document.copy.createnew],
[document.copy.description], [document.copy.editproperties],

[document.copy.extensions], [document.copy.layouts], [document.copy.maxlevel],
[document.copy.newestversion], [document.copy.selectall], [document.copy.validate],
[document.copy.uncheckedextensions].

Copy via drag and drop

You can also copy a document to another folder or project using drag and drop.

Select the document in the document list and drag it with the left mouse button pressed, a [+]
symbol appears at the mouse pointer, over the destination folder until it is marked in grey.

If no [+] symbol appears on the mouse pointer, you are still in move mode. By holding down the [Ctrl]
key, you force the copy mode.

After you have released the mouse button, the Copy Document dialogue appears.

Linking by Drag and Drop

To create a link to an existing document in another folder or project, select the document in the
document list and drag it over the target folder by holding down the [Ctrl]+[Shift] key until the folder
is highlighted in grey.

After you have released the mouse button, a link is created to the document in the destination folder.
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This is recognisable by the left symbol.
Copy document in the same project

If the article is to be copied in the same project by drag & drop, hold down the [CtrI] key. The mouse
symbol changes to a [+].

Copy document properties to the clipboard

[Ctrl]+[C] in the document list copies the document objects and the document number to the
clipboard.

If several lines are marked, the document numbers are also copied to the clipboard separated by a
line break.

If the mouse pointer is positioned over a column, the property of the column is copied to the clipboard
instead of the document number.

Delete document

Ribbon: Document “ Delete {[Ctri1+[X]}
Delete toolbox
Context menu document list ,, Delete

€
Drkoummente Wischen | Werknaplung entleman?

M bosrers S il B Sachardhen Dl s e
urel B erstfarrenden Verknupfungen.

o

The marked documents are listed again for confirmation in the ,,Delete Documents” dialogue after the
command has been called. All documents that can be deleted are marked in the list. The list
symbolises whether the document or a link to the document will be deleted (see also the tooltip).

S >
Markieren Sie die zu laschenden Dokumente.

x Cokument wird geloschi,

| Dokumant ist im Ordner verknlpft. Die Verknipfung wird aus dam Grdner entfamt
E Das Dokument ist verknUpft, Die verknipfung wird entfernt.

) Das Dokument wird von sinem Suchordner angezeigt und kann an dieger Stalle nicht geloscht werden.

speedyPDM - Wiki - https://wiki.speedy-pdm.de/


https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:delete.png
https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:delete.png
https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:dlgdocumentdelete_tooltip.jpg
https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:dlgdocumentdelete_tooltip.jpg

Last update:

2023/01/25 07:32 en:speedy:10_explorer:20_documents https://wiki.speedy-pdm.de/doku.php?id=en:speedy:10_explorer:20_documents

Iltems that have already been exported once (export to merchandise management)
can only be deleted by the administrator.

Lock document

It is possible to lock documents via the purpose of use and thus define changes, installation in
assemblies and properties. The document can then no longer be edited.

A user who has the authorisation: UsageEditProperties can, however, continue to edit and change
them.

Necessary settings for the usage purpose:

e Allow editing -» Unchecked

¢ Allow insertion = Unchecked

e Check user rights - ticked

¢ Possibly remove the purpose from the direct search.

This locks the document for this purpose.

Undo

Ribbon: Edit > Undo {[Ctri]+[R]}
Context menu: Undo {[Ctri]+[R]}

Undoes the last editing of a document.

Undo approval

Ribbon: Edit > Cancel Release
Cancels the last release. The revision counter is reset. The document can then be edited normally

again. However, the document is in such a state that it is waiting for a new release. This is indicated
in the document list by a corresponding symbol.

Search documents

Ribbon: Structure > Search {[Ctri]1+[F]1}
Search Toolbox
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speedy offers various possibilities to search for documents by their properties and to list them in a hit
list (search results in the navigation window). The following criteria apply to all options:

e The search for documents is only carried out within a locker.

* The search is based on the current document versions, i.e. older versions/revisions are not
included. In the version window, the latest version/revision that meets the search criteria is
highlighted.

e The documents found are automatically displayed in the document list and can be edited from
here.

e When searching for text entries, the * or % sign can be entered as a placeholder for any text:
Ex: all documents containing ,MV5“ in the designation “ *MV5* all documents whose
designation begins with ,On“ ,, On*.

¢ When searching for text entries, the ? character can be entered as a placeholder for any
character.

e Text entries are not case-sensitive.

e Special characters (* ? % _) in the search can be masked with a so-called escape character (\).

Enter your search terms in the respective input fields.

All entered search criteria (input fields) are linked with AND, i.e. all search criteria must be fulfilled in
the document properties. Example: Entering *Holder* in the document name and Festo in the supplier
searches for all documents that have the term holder in the document name and have Festo defined
as the supplier.

If you want to search for several criteria in one input field, the search criteria must be separated by ||

characters. Example: You want to search for all items that have Bosch OR Festo as supplier > Bosch ||
Festo.

Search filter:

Filter Meaning

<> wert Der angegebene Wert darf NICHT vorkommen

> value Search for values greater than the specified value.

< wert Suche nach Werten, die kleiner sind als der angegebene Wert.

>= value Search for values that are greater than or equal to the specified value.

< wert Suche nach Werten, die kleiner oder gleich sind als der angegebene Wert.
* Beliebiger Text an der Stelle
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Filter Meaning

? Beliebiges Zeichen an der Stelle
wertl | wert2
wertl OR wert2
conditionl & condition2  |Suche nach Bedingungl und Bedingungl.
conditionl AND condition2|z.B. >50 & <80

wertl :: wert2

wertl BETWEEN wert2

Suche nach Wertl oder Wert2

Wertebereich zwischen Wertl und Wert2

Speichern

th

Wenn Sie immer wieder nach den gleichen Begriffen suchen mussen konnen Sie hierzu einen
Suchfavoriten ablegen. Definieren Sie Ihre Suchbegriffe im Suchdialog. AnschlieBend geben Sie den
gewulnschten Favoritennamen in der Kombinationsliste (linke untere Ecke des Suchen Dialogs) ein
und betatigen den Speichern Schaltknopf.

Die Suchfavoriten stehen Ihnen zum schnellen Zugriff im Aufklappmen( unterhalb der Suchen
Schaltflache direkt zur Verfigung:

Schnellsuche

Mit der Schnellsuche kénnen Sie eine Dokumentsuche ausldsen, die automatisch in den wichtigsten
Datenfeldern der Dokumenteigenschaften sucht.

Schnellsuche ;
Irl I

Werkzeugkasten Schnellsuche

Geben Sie einfach den gesuchten Begriff in das Schnellsuchfeld ein und bestatigen Sie mit der
Eingabetaste. Beispiel: Sie suchen einen Zylinder: Eingabe in der Schnellsuche Zyl

Es werden alle Artikel aufgelistet die Zyl im Dokumentnamen, der Benennungl, Benennung 2,
Benennung 3, Lieferant, Material oder Oberflache haben.

Sie suchen alle Teile, die als Oberflachenbehandlung eloxiert sind: Eingabe in der Schnellsuche
eloxiert
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Dateien importieren

Ribbon: File » Importieren » Datei importieren

Importiert eine oder mehrere gewahlte Dateien und erstellt daraus jeweils ein speedy/PDM Dokument.
Wechseln Sie vor dem Befehlsaufruf in den gewlinschten Ablageordner mit Hilfe des
Navigationsbaums. Nach Befehlsaufruf werden Sie aufgefordert eine oder mehrere Dateien
auszuwahlen. Der Dialog fur ein neues Dokument wird angezeigt. Der Dateiname wird bereits als
Benennung vorgeschlagen. Nehmen Sie weitere Einstellungen vor und bestatigen Sie den Dialog mit
OK. Der Artikel wird angelegt und die Datei im speedy/PDM SchlieRfach abgelegt. Wenn Sie mehrere
Dateien importieren erscheint nach dem ersten Import die Abfrage, ob die weiteren Dateien
automatisch importiert werden sollen. Wird dies mit ,Ja“ bestatigt, werden alle weiteren Artikel
automatische importiert und abgelegt.

Speedy unterstitzt das Importieren von Dateien per Windows Drag & Drop oder Uber die
Zwischenablage.

apesdyPON

—
=

Zu ZIP importieren

Menu: Datei > Import > Import to ZIP

When importing one or more selected files, they are packed as a ZIP file and imported as a
speedy/PDM document.

Import from clipboard
Menu: File > Import > Clipboard
Imports the content of the clipboard as a new speedy/PDM document.

Import snapshot
Menu: File > Import > Snapshot
Imports a screen snapshot as a new document.

Import TWAIN

Menu: File > Import > TWAIN > Import

Imports an image from a TWAIN compatible device (e.g. scanner or camera). After the command is
called, a device-specific dialogue appears. Make all settings here and scan an image. After successful
scanning, the New dialogue appears and prompts for further entries. In most cases, the scanner
dialogue remains active and allows further scanning of images.

Select TWAIN source

speedyPDM - Wiki - https://wiki.speedy-pdm.de/


https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:import.png
https://wiki.speedy-pdm.de/lib/exe/detail.php?id=en%3Aspeedy%3A10_explorer%3A20_documents&media=speedy:explorer:dokueigen:import.png

Last update: . . . il : id—an- . .
2023/01/25 07:32 en:speedy:10_explorer:20_documents https://wiki.speedy-pdm.de/doku.php?id=en:speedy:10_explorer:20_documents

Menu: File > Import > TWAIN > Select Source
Allows you to select a TWAIN compatible device. If there are multiple TWAIN compatible devices, you

can select the device to use before importing.

Import Outlook Email

Outlook emails can be dragged and dropped into speedy: Drag and hold the Outlook email with the
left mouse button and drop it in the document window.

e

(L1 1]

L1
=

A new dialogue for emails opens in which all settings for the email document can be made.

If there are attachments to the email, a dialogue opens in which you can select what happens to the
attachments. Here you can make general settings for the email document and also settings for the
attachment. Attachments can either be saved as an independent new document (Save as own
document) or attached to the email as an attachment file (Save as attachment file). If the email is
only to be saved as such, this can be done with the selection do not save separately can be done.

If the attachment is to be saved as an independent document, you can enter the document settings
such as document type, container and naming directly and no new dialogue is required for the
attachment. If you leave e.g. the document type empty, a new dialogue is called up for each
attachment. Only attachments that are ticked are imported!
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Export
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Export files

Ribbon: SPEEDY > Export > Export file

Exports the files of one or more documents to a local directory or a zip file.

Select all documents whose files you want to export. If whole assembly structures are to be exported,
it is sufficient to mark the top assembly for export. The export command shows all sub-assemblies
and parts referenced by an assembly.

[renpmm.

%

&
The list shows all files of the previously selected documents. Individual files can be deselected again
here. To deselect or select individual files, click on the respective checkbox in the list.

Save in

Defines a directory into which the files are exported.

ZIP Pack

Activate the check box to export the selected files packed as ZIP. The property ,Save in“ now defines
a file name for the ZIP file.

Version

Select a specific version of the document for export.

Remove revision [?]

Defines whether the revision number should be removed from the file name for revisions.
Preserve structure Defines whether the file storage structure as it exists on the file server is
preserved in the export. If this option is deactivated, all files are exported to one directory.

Filter file type

The list shows all file types of the files to be exported. By activating or deactivating a file type, the
corresponding files are selected or deselected in the file list.
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Export to ZIP

Ribbon: SPEEDY > Export > Export as zip file
Menu: File > Export > Export file as ZIP
Exports the files of one or more documents packed as ZIP into a local directory. The ,Export File”

dialogue appears with the ,ZIP Pack” check box already activated.

Export document data

Ribbon: SPEEDY > Export > Export Metadata
Exports the document properties of one or more documents. All document properties of the
previously selected documents are exported to a file. The following file formats are available:

e XML - format

e CSV format

e Excel workbook
¢ Rich Text Format

Send Message/Zip

L™
s

Send message

Menu: File > Send message

Sends the files of the marked documents by email. All files of the previously marked documents are
attached to a new email.

Send ZIP

Menu: File > Send ZIP

Sends the files of the selected documents by email. All files of the previously marked documents are
packed into a ZIP file and attached to a new email.
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